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PART 1 Purpose & CI

What is CI ?

® Continuous integration
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PART 2 Eclipse

< eclipse

® Eclipse is an integrated development environment (IDE).

® It contains a base workspace and an extensible plug-in system for
customizing the environment.

® Written mostly in Java, Eclipse can be used to develop applications.
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How to install Eclipse

1. IDK(Java Development Kit) EX|

Oracle 21| 0| X| M : http://www.oracle.com/index.htm|

Downloads = Java for Developers £ &l

Sign In/Register Help Country » Communities » lama...*

ORACLE

Products Solutions | Downloads | Store S

Database Enterprise Management
Popular _
Downloads Oracle Database Oracle Enterprise Manager
Oracle Database 11g Express Cracle Application Testing Suite

' |Java for Developers Edition SeeAll...
1 MySQL
j:: fsc:IrEYuur Computer O:acle Berkeley DB Server and Storage Systems
Solaris Oracle Instant Client Solaris
WvSaL Oracle Application Express Linux and Oracle VM
¥ See Al Firmware
Oracle Fusion See All...
Middleware 11g Middleware
Oracle Database Oracle Fusion Middieware
Prebuilt Developer VMs (including Cracle Weblogic Server)
Oracle JRockit
Oracle SOA Suite

See All...


http://www.oracle.com/index.html
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How to install Eclipse

1. IDK(Java Development Kit) EX|
JIDK CtR 2 E

Overview Downloads Documentation Community Technologies Training

Java SE Downloads

= Java %2 NetBeans

Java Platform (JDK) Bud0 MetBeans with JDK &

| Java Platform, Standard Edition

Java SE Budo

This latest release of Oracle’s implementation of Java SE, JDK 8u40, brings improvements to
performance, scalability and administration, making it easier for Java developers, partners and IT
decision makers to innovate faster in a simple, easy manner and improve application services.
The release also includes new updates to JavaFX. Full release notes can be found here.

Learmn more #

« Installation Instructions JDK
IR Ty WA E



1. IDK(Java Development Kit) EX|

. ELLLLLLLLLLLLELLLLLELLL

DK |:|._8_§E Java SE Development Kit 8u40; <€ el
You must accept the Oracle Binary Code License Agreement for Java SE to download this :
software. 1
I
.?.I (o] I xI-E (Just JDK) Accept License Agreement * Decline License Agreement -
I
I
Product / File Description File Size Download 1
H2 7} Qe HA. !
Linux %86 T4684NB ¥ jdk-Bu40-linux-i586.rpm '
AMEXIO| LAK|H| EHA ! * jdk P I
FEXIS] 2 A 20 Linux x86 166.85MB ¥ jdk-Bu40-linux-i586 tar gz !
OtE| M CH2 HHO M Z|C  Linux x4 14514 MB ¥ jdk-Bu40-linux-x64.rpm I
. " A1 Ad a Linux xG4 165.17 ME 5 il apdn-line-yfid tar gz 1
Ol ==MEO CHot ZX[ 2L At rl'-.ﬂaci}S){!Bel 221-% ME g [dk-Bud0-macosx-x64.dmg | :
solans SFARC 64-bit (5VR4 package) 13909 ME  # jdi-2udo-solaris- O tar 7 I

=2 CL0OH} e o * jdk-Bud0-solaris-sparcyd tar.
& 7I0IE= B BES  soraris sParc sa-bi 98.68 MB 3 jdk 5ud0-solaris-sparcyd.tar gz !
_|':_ 7|.X|% 7|_7F_9§ Ell-g-(}/\l:l'- Solaris xG64 (SVE4 package) 13057 MB ¥ jdk-8ud0-solaris-x64 tar.Z 1
Solaris 164 89.91MB _ $ k840 colaric vRdtar o2 :
Windows x86 17571 ME ¥ jdk-8ud0-windows-i586.exe :
Windows xG4 18019 ME ¥ jdk-8u40-windows-x64 exe I
e [
-l

Java SE Development Kit Bu-lmDenms and Samples Downloads '€ =======—-

You must accept the Oracle BSD License. to download this software.

OI'EH xI‘E (J DK+ DEM O) Accept License Agreement '* Decline License Agreement

Product / File Description File Size Download

Linux x86 524 MB # idk-Bud0-linux-i586-demos.rom



1. IDK(Java Development Kit) EX|

IDK A %] 7184

i) Java SE Development Kit 8 Update 40 (64-bit) - Setup

Welcome to the Installation Wizard for Java SE Development Kit 8 Update 40

This wizard will guide you through the installation process for the Java SE Development
Kit & Update 40,

The Java Mission Control profiling and diagnostics tools suite is now available as part of
the JOK.

#¢  Java SE Development Kit 8 Update 40 (64-bit) - Custom Setup

Select optional features to install from the list below. You can change your choice of features after
installation by using the Add/Remove Programs utility in the Control Panel

Feature Description

=M oevelopment Tools Java SE Development Kit 8
rp——— e 411 (54 bt ichachiny e

) JavaFX SDK, a private JRE, and
- &3~ | Public JRE the Java Mission Control tools
suite. This wil require 180ME on
your hard drive.

Install to:
C:WProgram FilesWlava'ftidk1.5.0_404W Change. ..

= ==
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How to install Eclipse

1. IDK(Java Development Kit) EX|
Java AKX 2 22l = SA (28 2F0M 4= X|F Al ER5t0tH)

Java 2| - jAF =0

o4 =

Javas CHE EHY S2ASIHE "EE"S FEEAZ.

L7 27: 230
C:\Program Filesh)avahjre.8.0_404

FENNIN
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271(0) . HoiE = HIE Y S 7|2 HE &
22/(G)
A BHBI0] D (P) B TN TR Windows H &
HEI CEH0[E HT(N)... FH E'l"ff:g ~ Windows 8.1 Enterprise K
HEYI E2H0|E HE 27|(C)... |EI dos s © 2013 Microsoft Corporation. s
| | NS A~
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to install Eclipse
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canine89H CHEH ALE A BEa=(1)

e a

TEMP 2eUSERPROFILES:WAppData®LocalWTemp

T™P 2:USERPROFILES:AppDatawLocalwTemp
ME HSI[(N)... EHEE.. ALFH(D)

LCOM;.EXE, BAT;. CMD NBS, VBE; 15, J5ELW...
AMDE4
Intelg4 Family & Model 30 Stepping 5, Gen...

PATHEXT
PROCESSOR_ARC...

PROCESSOR_IDEN... -

ME ZHS2I0W)... EHEQ.- AHHI(L)

B Ol (N): Path

| IToemSystem32wWindowsPowerShel sl 0w, |

Lot

o LB

|

—_—

A|ﬁE+I E_JI\_ X! JctDI-Q| CC H
0l OM7F = AfSHE At 2



4 C:#Windowstsystem32itcmd.exe

icrosoft Windows [Uersion 6.3.9608081]
Cc? 28013 Microsoft Corporation. All rights reserved.

|

|

|

|

|

|

|

|

I

I

I

I

I

I

I

I

I

I

I

I

I

|

: MlzersWcanined?>java —version

| java version "1.8.68_48"

| avat{TM} SE RBuntime Environment ¢(huild 1.8.0_48-h26>
[ ava HotSpot(THM> 64-Bit Server UM (build 25.40-bh25, mixed model
|
|
I
I
I
I
|
|
|
I
I
I
|
|
|
|
|
|
|
|
|
|

tlzersthcanineB9>
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How to install Eclipse

4. Eclipse 2X|

Eclipse C}2 2 E AO|E 7= : https://eclipse.org/downloads/

X Ol mRFE| Tl
2| AR 7H0|EE
ecl I pse 2014HE0| LI Lunaz2 72
XA A Ol 441014425
7|Ee = AERlCk

GETTING STARTED MEMBERS PROJECTS MORE~

S AR M

Eclipse Luna SR2 (4.4.2) Release for Kt

Eclipse IDE for Java Developers 155 e
Downloaded 732,542 Times Windows 32 Bit

€ Windows 64 Bit
The essential tools for any Java developer, including a Java IDE, a CVS client,



https://eclipse.org/downloads/
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How to install Eclipse

4. Eclipse 2X|

Eclipse downloads - mirror selection

All downloads are provided under the terms and conditions of the Eclipse Foundation X El‘—E—EE Al?_"%

Soft u tunl therwi ified. o
ortware user Agreemen uniess otnerwise specne Ol_l E‘I LjI\I %I_7o:| 0_” [[l‘E_l-
Download eclipse-java-luna-SR2-win32-x86_64.zip from: CIEX|2L HE 52 Q|2
o [
[Korea, Republic Of] Daum Communications Corp. (http) |:|-—|,_—§57|- 7|_3O|'|:|--

=== Checksums: [MD5] [SHA1] [SHA-512]

ezc oz Thank you for downloading Eclipse

If the download doesn't start in a few seconds, please click here to start the download.




5. Eclipse A3

o WPC » O2ZECE

T . T e =F]
| I eclipse-java-luna-SR2-win32-x86_64 2015-03-16 2= L2 =0 |
[ £ jdk-BuL0-windows-x64 exe 2015-03-16 2= =8 EEJE 84,515KB

o r WPC » TH2EL b eclipse-java-luna-SR2-win32-x86_84 » eclipse »

. v WPC » TH2EC » eclipse-java-luna-SR2-win32-x86_64 » 0= - =R LW}

01 ’ TR ER RE , configuration 2015-03-16 2%
w eclipse 2015-03-16 23 I =0 ., dropins 2015-02-19 27

) features 2015-03-16 2%

| p2 2015-03-16 2%

, plugins 2015-03-16 2%

., readme 2015-03-16 2%

L . — " || .eclipseproduct 2015-03-16 2%

E|"E‘§E O|_|- Edlpse %E-l c)Izll-é"t'l_ OHX-" || artifacts.xml 2015-03-16 2%

- eclipse 2 eclipse.exe (S edlpsecre ohee e

£ | eclipse.ini 2015-03-16 2%

(551 eclipsec.exe 03-16 2=

|=] epl-v10.html 20T5-03-16 2%

|=] notice.html 2015-03-16 2%
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How to use Eclipse

1. Eclipse &<l

Eclipse A|%} Al workspace &7 (Afdet Z=2HMEV HYEH 42 2%)

Workspace Launcher

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: | /Users/minwookim/Documents/workspace \v| | Browse... \I

[_] Use this as the default and do not ask again

|  Cancel |




1. Eclipse &<t

606

Java EE - Eclipse - /Users/minwookim/Documents/workspace2

&) Welcome X

i

{ Overview
S,J Get an overview of the features

@" , Samples
~ Try out the samples

Eclipse Java EE IDE for Web Devy

{'L‘ A A T, =08
.
Workbench

@zt k2 $HHO| EEH, workbench

(B8 Al ofHet 22 S8 2 A HE

8 06

Java EE - Eclipse - /Users/minwookim/Documents/workspace2 "

i

FSA00 R SRR S At TR FO BRI It SNV I SR SRR .

_— f
(" Quick Access J ;21 [gjava EE

I Project Explorer 22 = | = B8 2= outline R TaskList = O
w Tutorialg =R- g
Go through An outline is not available.
A
_/"_ What's N
V Find out wh
12 Markers 2 Properties Servers Data Source Explorer - Snippets v=ag
0 items
4  Resource Path Location Type

|
|
|
|
|
I
I
I
I
|
|
I
I
I
|
|
|
I
I
|
|
|
|
[
N
[
[
|
|
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
|
|
|
|

0 items selected




Windows2| A% Eclipse A& = AEHHICS| Window > Preferences
MacO| 42 ACHHIO| Eclipse - =2H4A™

v Windows

S Java - record/src/com/example/record/MainActivityTest java - Eclipse
1

File Edit Source Refactor Mavigate Search Project Run | Window ] Help
C~E- i W8 G - R E]|  NewWindow G
- Editor 3
- = ;
2 P_ackage Explorer 3 = =g>| e 8  [J] Ma Hide Toolbar Bva i3
¥V Mac . = EDLS 1
I EDLS_unit_test 2 Open Perspective v
. - 3 .
m File Edit Source Refactor Navigate Search Project Run Window Help : Show View (3
Eclipsed| 2510 ‘ ) Java - SV_Test/src/HelloSV/HellowSV.java - Eclipse - /Users/minwookim/Docum g ) )
| . . - o 18 Customize Perspective...
5 v g Give 5 Sl 6 - B ok v v ”
g, ®, qu" RN CAR. =Rs RN ETL ST A e 115 Save Perspective As..
MH|A > = [J] *HellowsV.java 52 1; Reset Perspactive._ xception {
B & 1 k HelloSV; Close Perspective
Eclipse 712|7] %H 1 5 ¥ 2 package Tt 1:— > :
7|} 7217 T $8H = - Close All Perspectives s Exception {
Qs H7| 4 public class HellowSV { 17 L
lavaSE-1.7] 5 public static void main(String[] args) { 15 Mavigation 4
Eclipse E2 ®¥Q = b // TODO Auto-generated method stub 1;_
7 System.out.println("Hellow SV World!!!!11"); Preferences
8 }

5 3

S T S
MR @

Fail ("Not yet implemented™);



—— i e .
I 2 ElIZ2NMEE 2ot StAMXN T
| O —T1—= TI T o=20o
| 1)Encoding Ef2} &4 : HE utf-8
| Java EE - Eclipse - /Users/minwookim/Documents/workspace2
e e 1
I 1806 Preferences
I | (type filter text Workspace =1
I V¥ General . |
I » Appearance See 'Startup and Shutdown' for workspace startup and shutdown preferences.
I Capabilities
Compare/Patch # Build automatically
| Content Types
I » Editors Refresh using native hooks or polling
Globalization  Refresh on access
| Keys
» Network Connections Save automatically before build
I Perspectives Al | Jated {ectewithont t
I Search ways close unrelated projects without promp
| » Security
Service Policies Workspace save interval (in minutes): 5
I » Startup and Shutdown
I Tracing Workspace name (shown in window title):
Wob
I » Workspace R o
Open referenced projects when a project is opened
I » Data Management
| » Help _ Always | Never () Prompt
» Install/Update
I VJava
I » Appearance Command for launching system explorer: open -R "${selected_resource_loc}"
» Build Path
| » Code Style
I ¥ Compiler Text file encoding New text file line delimiter
Building
I Errors/Warnings Default (UTF-8] (») Default (Unix)
Javadoc = her: ] fher: [ U
| Task Tags () Other: |UTF-8 v Other: nix
| » Debug 1SO-8859-1
» Editor US-ASCII
I » Installed JREs UTF-16
JUnit
UTF-16BE
I Properties Files Editor Restore:Defaults Apply
I s P _UTF-16LE
UTF-8 —
| Cancel § OK



2.El mRHEZ Q5 SHAMN Tip

2)JDK Aot ™ &Y :2015/3/19 7|=2=217/18 (DK 7 / JDK 8)

Java EE - Eclipse - /Users/mlnwooklm/Documents/workspaceZ

1©0 6 Preferences
f
type filter text Compiler
» General
» Ant
» Data Management JDK Compliance
» Help
> Install/Update I Compiler compliance IeveI:I
¥Java — A
» Appearance  Use default compliance settings
» Build Path Generated .class files compatibility:
Source compatibility: 107 =
F_rrors/Warmngs Disallow identifiers called 'assert': Error
Javadoc . ; ;
Task Tags Disallow identifiers called ‘enum": Error
» Debug
» Editor Classfile Generation
» Installed JREs
JUnit ¥ Add variable attributes to generated class files (used by the debugger)
5y PrEo:erties Files Editor  Add line number attributes to generated class files (used by the debugger)
ava
» Java Persistence Qf Add source file name to generated class file (used by the debugger)
» JavaScript @ Preserve unused (never read) local variables
» Maven
» Mylyn v/ Inline finally blocks (larger class files, but improved performance)

» Plug-in Development
» Remote Systems
» Run/Debug
> Server
P Team
Terminal
Validation
»Web
> Web Services
» XML

Store information about method parameters (usable via reflection)

| Restore Defaults Apply

Cancel | OK |




2 5 ZRMES Qs $EAH Tip

3)Installed JREs =tQl : 2015/3/19 7|&=2 =2 17/18 (JDK 7 / JDK 8)

Java EE - Eclipse - /Users/minwookim/Documents/workspace?2

|

|06 Preferences i
! ||
type filter text Installed JREs (=1 v v
> General
» Ant Add, remove or edit JRE definitions. By default, the checked JRE is added to the build path of newly
created Java projects.

» Data Management
» Help
» Install/Update .Installed JREs:
¥Java Name Location Add...
b Appearance =i Java SE 6 [1.6.0_65-b14-462] /System/Library/Java/JavaVirtualMachine
P Build Path  miJava SE 7 [1.7.0_71] (default) /Library/Java/JavaVirtualMachines/jdk1 Edit
> Code Style
¥ Compiler
Building
Errors/Warnings
Javadoc Remove
Task Tags
» Debug Search...

¥ Installed JREs

Properties Files Editor

b Java EE
P Java Persistence
> JavaScript
> Maven
P Mylyn
» Plug-in Development
» Remote Systems
» Run/Debug
> Server
» Team

Terminal

Validation
»Web
> Web Services
XML

Duplicate...

@ Cancel | [ 0K \




3. Z2ME Ot=7|

Project Explorergjj Al QL EZF Ot A 22! 5 new > project

(@006 Java EE - Eclipse - /Users/minwookim/Documents/wi
3 150 Qi GG ®G S @iaRiN] | =,
SR-Y A
New > m Project...
Show In XaEW > & Application Client Project
Copy 5C ;:= Connec.tor Pro;ect.
Copy Qualified Name : Dynamllc Web Project
“ Paste 8V ;j EIB Project _
Delete 2 .u. Ente.rprlse Appllcatlon Project
21 Static Web Project
Import > G Web Fragment Project
i1 Export...
7 Example...
# ] Refresh F5

m [ Other... ¥EN

|
|
I
I
|
I
I
I
I
I
I
I
I
I
I
I
|
I
|
[
[
[
[
[
| [ Project Explorer 52 "
[
[
[
|
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
|
|



3. Z2ME Ot=7|

Java = Java Project &> Next

e O 6 New Project

Select a wizard

<7

Create a Java project

Wizards:

( type filter text

'[gjava Project
£ Java Project from Existing Ant Buildfile
Ly Plug-in Project

P (= General

b (= CVS

P (= Eclipse Modeling Framework

» (= EJB

¥ (=Java
Ejava Project

% Java Project from Existing Ant Buildfile
P (= Java EE
P [ JavaScript
> (= JAXB
P (=]JPA

® < Back Il Next> || [ cancel | Finish
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How to use Eclipse

3. EEX—”E Dl_l-%jl 8 00 New Java Project |

Create a Java Project ;
— Create a Java project in the workspace or in an external location. /
TZ2ME O|EAMH o i
— —1— o = O

9 F| n |Sh Project name: {Sv_Test I

# Use default location

Location: /Users/minwookim/Documents/workspace2 /SV_Test Browse...
JRE
(*) Use an execution environment JRE: | JavaSE-1.7 =
(_ Use a project specific JRE: Java SE 7 [1.7.0_71] O
__ Use default JRE (currently ‘Java SE 7 [1.7.0_71]) Configure JREs...

Project layout

() Use project folder as root for sources and class files

(*) Create separate folders for sources and class files Configure default...

Working sets

| Add project to working sets

Working sets: B Select...

'@) |  <Back | Next > | Cancel |




3 1L EI_‘lIE O I'%j | ! 8006 I New Java Project I

i‘ Java Settings o
A‘" H x_l OI A'” I | Define the Java build settings. @
T 1

[TETM7T (=Projects | miLibraries | 4 Order and Export |

@ . [~ FYRIEYO)

N
ofn
oln

library =
- Finish

~ Details

&' Create new source folder : use this if you want to add a new source folder to your
project.

iﬁ Link additional source : use this if you have a folder in the file system that should be
used as additional source folder.

Q? Add project 'SV Test' to build path : Add the project to the build path if the project is

the root of packages and source files. Entries on the build path are visible to the
compiler and used for building.

|| Allow output folders for source folders

Default output folder:

SV_Test/bin | | Browse...

® . <Back | Next > Cancel I[ Finish ]I
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How to use Eclipse

4. C | a SS Dl_l-%j | ® 00 Java - Eclipse - /Users/minwookim/Document

src - SV_Test

|
|
I
I
I
I
I
I
I
I
I
I
I
I
I
: - 350 0v Qe B G SO SN
: EEX_‘I!E Src i;r';E' [£ Package Explorer 2 - ‘ = Elv
[ v [=)SV_Test E
| > 2EF OS2 Y s 7
=1 = "1 » =0 JRE Syste (= Java Project
! Open in New Window ™ Project...
! 9 N ew Open Type Hierarchy F4 & Package
| howin .
= Copy 3%C & Interface
| 9 C I ass = Copy Qualified Name & Enum
| 7 Paste .YV @ Annotation
I % Delete ® &’ Source Folder
I 19 Java Working Set
[ Remove from Context {38l 9 Folder
| gzli.:?cepath N 8S : Bk
I Refactor T 4 ; Untitled Text File
I 7 JUnit Test Case
[ 4 Import... 7 Task
! e i ™ Example...
! i Refresh 2 —
| Assign Working Sets... T Other... ®N
: Profile As >
Debug As >
[ Run Ags >
I Validate avadoc Declaration
I b i : ; 4 Resource
| Compare With . >
| hRAestore from Local History... y
aven
: Properties 73&
|
I
|



4. Class Br=7|
New Java Class %t
- Package : I{7|X| X|™
("R Al &)
- Name : Class 0|5 X|™
- main = ClassE &gt

=R ECENPIEY

How to use Eclipse

® 006 New Java Class

Java Class

1. This package name is discouraged. By convention, package names usually start
with a lowercase letter

€

Source folder: SV_Test/src | Browse... |
Package: HelloSV | Browse... ||
[ | Enclosing type: Browse...
Name: | HellowSY| ‘ I
Modifiers: (®) public () package private protected
[ ) abstract (| final static
Superclass: java.lang.Object | Browse... |
Interfaces: LiAdd... ]
Remove
Which method stubs would you like to create?
# public static void main(String[] args) |
[ ) Constructors from superclass
# Inherited abstract methods
Do you want to add comments? (Configure templates and default value here)
[ ) Generate comments
" —
(?/I [ cancel | [ Finish |




5.

Z2HE
Edit AOA TE ZH > X2M E7710|2 &l > HA| 9

2 Hrun

v 22l 5> Run As

e 06 . Java - SV_Test/src/HelloSV/HellowSV.java - Eclipse - /Users/minwookim/Documents/workspace?2 "

: e S s | - — Ry

- u#lo'k' # Gri®E Ay 2‘3* (Nt v e oG { Quick Access ) ) 1 121 IT'JavaEE &Java
7 1 HellowSV

I% Package Explorer 53

0% % | & | X E
v & sv_T .
Lv/sm' o 0rgamze Favontes lic class HellowsV { v
& src q
v i Hellosv 5 public static void main(String[] args) { Find P Al P Activa...
b |J] HellowSV.java // TODO Auto-generated method stub
» m, JRE System Library [JavaSE-1.7] System.out.println("Hellow SV World!!!!! ![D
9 }
L @® Connect Mylyn
Connect to your task and
ALM tools or create a local
task.
X} = o -0
Ed t o= Outline 23
I S L
S I C KHM S Lt
-
— T1 O
# Hellosv
v @, Hellowsv
& ° main(String)) : void
Problems Javadoc Declaration & Console % X x\ HEE »E--=0

3V.iava 23 = B E Task List % =0
1 1 Java Application 088X J

<terminated> HellowSV [Java Application] /Library/Java/JavaVirtualMachines/jdk1.7.0_71.jdk/Contents/Home/bin/java (2015. 3. 19. 2% 7:!

Writable Smart Insert | 7:50
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JUnit

® A unit testing framework for the Java programming language.

|
|

!

!

|

|

!

!

|

!

!

|

|

!

!

|

| A simple framework to write repeatable tests

: An open source framework designed for the purpose of writing and running tests

i HEE X Ol O HIAEE 24067 | ot ZHERStunit testing framework @ 2, EHS| AtHp 2 2
o ARRElD, 9= AA 2 HZEIC

|

| . . . .

' ® JUnit has been important in the development of test-driven

|

' development, and is one of a family of unit testing frameworks
|

. which is collectively known as xUnit that originated with SUnit.

|

|
|
|
|
|
|
|
|
|
|
|

Smalltalk 7|8FQ| unit testing2| frameworksQ| Il =l HEl. Test case| Atz 3}

® JUnit is linked as a JAR at compile-time.

o Ol Z=HME Ciet 2X| X ALE 7H0|E=JUnit 7T 40| 2 7|22 2 AGRULE



® Unit testing is a software testing method by which individual
units of source code, sets of one or more computer program
modules together with associated control data, usage procedures, and
operating procedures, are tested to determine whether they are fit
for use. Intuitively, one can view a unit as the smallest testable part

of an application.

® Unit

Entire module, individual function or procedure.
programming

Object-oriented

Entire interface (e.g. class), individual method.

programming



® The goal of unit testing is to isolate each part of the program and
show that the individual parts are correct. A unit test provides a

strict, written contract that the piece of code must satisfy.

Unit CHR| 2 LR M testingdt] 2t UnitE A S 5t= 40| 2 H.

Unit Testing limitations

® Testing will not catch every error in the program, since it cannot

evaluate every execution path in any but the most trivial programs.

unit testing by definition only tests the functionality of the units themselves.
—> it will not catch integration errors or broader system-level errors.
3= 7|S0|Lt 02l S Ct test s = == 8l7] W= 0fl, 100%2] 021§ & OtLHX|= ZSHLY.
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Benefits of Unit Testing

® Finds problems early
TE XS SHHA ZittottestE Sal, LF7HH XH LIS A RS EofECt
® Facilitates change
Z2+24o| 7|51 method 0| CHSH test caseE LH=0], ZE0f| H7 MZS [ 0|2 QIS @ 2 HihAl
Ol Fet X HS WA &= = QU
® Simplifies integration
buttom-up testing styledj| HatSICt.
A2 B[R E HE test TRI2| 37| & Ho{7HH CHfot test E{0fl Chiet 2= +F 5| SHZLCL.
® Documentation
® Design
o .



® HAE AES BEO[ SaiA0N A-g5HH O] HIAE SeiAS =X 249 2P 2
2B AL Z 2e|E o= USS oftf

=
2> HAE Z1IE Test2AE HZ O Z 72X A HIAE 2 Bl Z2fA 9| History K&

P .6H|é|. —gp_)lx_()." EH'6|- AEI'c'SOH A| F% _-I?I-_A|'C'>'H g 91“:"

More about JUnit

® JUnit allows the developer to incrementally build test suites to measure
progress and detect unintended side effects.

® Tests can be run continuously.

® Results are provided immediately.



® JUnit2 Eclipse L{F0] O|0] AX|&|H

® x| CHAl
1L OIZHE M

M ZZHE MM > Next

- Libraries &4 - Add Library

JUnit 2fo|2.a{2|= st

O

Al 210[=2{2| =7t

N

Java Project

Project...

Package
Class
Interface
Enum

Annotation

= O

EE

ACE (= X2 2R G

Java Settings
Define the Java build settings.

2 source | L= Proje = Libraries

JARs and class folders on the build path:

‘> Order and Export

[ B JRE Systemn Library [JavaSE-1.8]

Add JARs...
Add External JARs...

Add Variable...

Add Library...

Add Class Folder...

Add External Class Folder..
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How to install JUnit

1 o2 HE Md Al 2f0|E2{2| =7t (A%

i
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I JUnit Library X JDK5.0 O|MEE FH0| 51 AF2to| QIO A
[ Select the JUnit ion t in thi ject.
| elect the JUnit version to use in this projec Ol O|é>|_9_| I:I'lX-I (=] E-I |- JUnIt4E |_-IE—I|.I-6I'IOI: -('5|_|:|_
I
| Junit library version: | JUnit 4 vI I_egacy prog ramE TIOI'IA-I JUhIt37|' IEI-OI' l'
I Current location: junit jar - C:¥eclipsewplug
: Source location: Mot found | |
& | - -
: > @ o Mew o ’
TL =
2. 7|=maMEe 2lo|Ea| =] Cl e
T == — T g —
| P @ Open in New Window
I a4 4 Open Type Hierarchy F4
o o
: -LLEX-II E TIO-IIA-I 2 I:II-_I_ﬁ 4 Show In Alt+Shift+W »
| o 4 @B Copy Ctrl+C
| 9 BUIId Path E5  Copy Qualified Name
| ’ % (@ Paste Ctrl+v
: - Add Libraries ... L@ % Deete Delete
I 4 Remove from Context Ctrl+Alt+Shift+Down
I ‘I Build Path » |55 Link Source...
[ Source Alt+5hitt+S » [ §%  New Source Folder...
| Refactor Alt+Shift+T » G Use as Source Folder
I fag  Import... s Add External Archives...
: . ml g | Export.. =i, Add Libraries...
| r_;aéh Refresh FS | g Configure Build Path...
| ’ Jr"-_-/| Close Project I
|



1. O 2=

i

* This class prints the giwen message on console.
i B
]

. public class MessageUtil { ® Oj|X| == 74X RISt Unit testing TH
| private String message; 1) printMessage()0]| CHt test case A4A

: i::i::.;;;f;uﬁzz;ageItc be printed 2) salutationMessage()0f| CH3t test case AdAd
T A 3) 0f2] B|AEZ 2+0| XISHSH= testSuite AAl

¥

. | L_ i
. /1 prints the messagd 4) testSuiteE F1=SH= runner AlsH
i public String printMessage(){
i System.out.println{message);
i return message;
= ¥
Jf add "Hil!" to the message
B8 public String salutationMessage(){
! message = "Hil" + message;
i System.out.println{message);
return message;

)



2. Test case A
=

Test St} SF= LA B2 OF2A 2> New = JUnit Test Case

Mew ¥ | (2% Java Project
hapt1_Client .
- Project...
hapteri Open s |0 !
1SBroker Open With v | B Package
:“mm}'d Open Type Hierarchy F4 | & Class
ummy .
Show In Alt+Shift+\W ¥ Interface
UnitTests +Shift=W |
AultiCast = Copy Ctisc |G Enum
ata B Copy Qualified Name @ Annotation
C
< = paste CtrlV &% Source Folder
L B A} -
ctes % Delete Delete 15 Java Working Set
B gre 9 Folder
Remove from Context Ctrl+aAlt+Shift+Down s | =
« [B (default suild Path ] File
b
- [B] Mess L e 2 Untitled Text File
Source Alt+Shift+5 » P
> 9] Test EF  Junit Test Case
» 4] Testl Refactor Alt+Shift+T» | o .Task
- [J] TestR =
> [3) Tests| 2 Import.. 5 Example...
g JRE System | fxg Export.. = oth |
i Other... Ctrl+M
JUnit 4
B References (JS




How to use JUnit

2. Test case A

SZ|A O|E K| > Next > Test 1A} = method&S MEH = Finish

JUnit Test Case
(v, The use of the default package is discouraged.

E

Test Methods
Select methods for which test method stubs should be created.

PART 3 JUnit

E

() New JUnit 3 test (@ New JUnit 4 test

Source folder: |Tester:’5rc || Browse...

Package: |

Mame: MessageltilTest]
java.lang.Object

Superclass:

Which method stubs would you like to create?
[]setUpBeforeClass() [ |tearDownAfterClass))
setUpQ tearDown()
constructer
Do you want to add comments? (Configure templates and default value here)
[] Generate comments

Class under test: | Messageltil

Available methods:

4 [W® MessageUtil

[ @ © MessageUtil(String)

@ printMessager)

[] e salutationMessage()
4 []® object

[] @ °© Object(

[ &'F getClassp

[ @ " hashCode()

[ e equalsiChject)

O " cleneg

[Je teString)

O &' netify

1 &' notifyallg

1 &' wait(long)

[] e " wait(long, int)

Select All
Deselect All

Finish | |

Cancel

L 11

1 method selected.

[[] Create final method stubs
[] Create tasks for generated test methods

® Mext > I| Finish |I| Cancel




3. Test case O|A|

V printMessage()0f| Cat Test code

1= import org.junit.After;
2 dimport org.junit.Test;

3 dmport org.junit.Ignore;
4 import org.junit.Before;
5
B

. & dmport static org.junit.Assert.agssertfquals;

7
& public class Testlunitl {
]

18 String message = "Robert”;

11 MessageUtil messageUtil = new MessageUtil(message);
12 @Before

13 public void setUp(){

14 System.out.println("Setup™);

15 3

6=  @after

17 public void tearDown(){]

18 System.out.println("tearDown™);

TR’

28 @Test

21 @Ignore

22 public void testPrintMessage2(){

23 System.out.println("0|d H=EX 3. ");

2}

258 @Test

26 public void testPrintMessage() {

27 System.out.println({"Inside testPrintMessage()");
28 assertEguals(message, messageUtil.printMessage());
29 1

3@

31

32 }

W 1% import org.junit.Test;[]

a

5 public class TestJunit2 {

[a BN, I S WV W Y T A

—

string message = "Robert”;
MessageUtil messageUtil = new MessageUtil(message);

@Test

public woid testSalutationMessage() {
System.out.println("Inside testSalutationMessage()");
message = "Hi!"} “"Robert”;
assertEquals(message,messagelltil. salutationMessage());

b

A salutationMessage()0f| CHjet Test code



testXXX()

stLto] HIAE

2t2to| BIAET} EOPHE BHY
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How to use JUnit

4. Annotation(@)
JDK5.0 O| 4R H HMEL|= 23z, Ii7|X|F & WK @F 0850 HEl HIO|H HE&
= Mg = Q= 7|SO|Ck

@Test Test | AE Q2 HA|TICH

@Test (expected=Exception.class) | T=0{%! exceptionS throwdtX| %2 AL fail oL

@Test(timeout=N) HAE7F N ms(milliseconds) O|AF Z 2l AL fail $HC}

e 24 249| test7h MAE|7| O HAN HAE|= HAE0|Ct Test 2HES FTH|SHY|
2|8l AtE=ICt (0 — read input data, initialize the class)
o 247t0| test7} MBE 20| HHE|E B4 E0|C} Test $AE cleanupd}?| ¢l
S ArEEICE (Ooff — A CIO|H AFA|, defaultz X{7ZH])
MK test7} A|ZHE| 7| FOf| oF H A= HAEO|C} O] annotationS ALE
@BeforeClass S BAC L statico 2 AMOfg|0fOf L},
Dl MA| testZ7} Lt H O o H AME| = A EO|C| O] annotationS A& O

AC L staticO 2 *1015|0'|0F CtCt.

@Ignore S| test HIAEE FA[oICE DE HA = test caseE O& HZASHA| AUS
I =23 2~ 9lCt.

= O =
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How to use JUnit

4. Annotation(@)

WTest |

1ﬁfgnure{"NDt working yet.!EI
public void testPrintMessage2(){
System.out.println{"0|H gl2=E0 2, ");

¥
@Test

public wvoid testPrintMessage() {
system.out.println{"Inside testPrintMessage()");
gssertEquals({message, messageltil.printMessage());

}

public class Testlunit2 {

String message = "Robert";
MessagelUtil messageUtil = new MessagelUtil(message);

= | @Testitlmeout=5@@5“

i

public woid testSalutationMessage() {
System.out.println{"Inside testSalutaticnMessage()");
message = "Hil!"+ "Robert";

assertEquals(message,messageltil. salutationMessage());

}

@TestE HA|SHY test method & MY

@Ignore(“blabla”);
TestZ OF St X|L}ZICE

@Test(timeout = 500)
ol|& methodZ} 500msE 4 7|H fail

otC

—

-



4. Annotation(@)

public class TestJunitl { @Before?2} @After=
String message = "Robert”; MM AHX|Z D HH &ICE
) Eéiiiii”ﬂl messagelltil = new MessageUtil(message); AMXH= testOl] TLRBH SFYAO| ZHH|Z AUAISIA
public void setUp(){ L} HEQ|a oA So| ot St 4 oI}
: A= BICHE O 22| 3N S2| IS oCf
publfc void tearDown(){ ) A™MZ Ot S|F=H default2 =ICH
) System.out.println("tearDown™); Ol T 3}X| oS
@RunWith(value=class) Test runner &2 TA|SHC}.
@SuiteClasses(value={classes}) Test suitesOf] Z&tE = QUEE ™HO|=l test S HA|SICH
@Parameters CtSE parametersOf| CHet multiple testE XS $HC.

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
: system.out.println{"Setup”);
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
|
|
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How to use JUnit

5. Assert Method (AssertXXX)
Asset method = 0| & 4}, sample | Bzt £f= X|HSHCE

Ofl & €X2f sample2f et £10] Z2H, testS SIS

@Test

public woid testPrintMessage() {
Syktem.out.println("Inside testPrintMessage()");
assertEquals(message, messageltil.printMessage());

1

@ void org.junit.Assert.assertEquals(Object expected, Object actual)
assertEquals

public static void assertBquals{0bject expected,
Object actual)

Asserts that two objects are equal. If they are not, an RasertionError without a message is
thrown. If expected and actual are null, they are considered equal.

Parameters:
Press 'F2° for focus
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How to use JUnit

5. Assert Method (AssertXXX)

AtE H| W= 02 methodE X|S2HC

F.

import static org.junit.Assert.*;

Asset Method

assertArrayEquals(a, b); Hi S AQ} B7} YX|&tS =tOlIstL}.

assertEquals(a, b); ZHH| A9} B7 LX|&HS =HQIBHL}

assertNot Equals(a, b); 2K A9 B7I 2 YX|et2 =Holst},
A At B7t 22 K Q2 =telstrt. assertEquaIs(a b)= & AH| 2t0] &

assertSame(a, b); 275 HASH= o Btslf assertSame(a, b),= & X7t S Lot7t, = StLtO|
AH I7HE = Rlotrt. (== ALK}

assertTrue(a); X A7} EQIZLHE = QIS

assertNotNull(a); 2K AZ} Nullo] ot =tolstLt.
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How to use JUnit

6. TestSuite
O | test method=& 2O0rA SO 20| Z2{= = UL,
File > New > Others = java = JUnit & JUnit Test Suite > Package, Name A%

- include &t test class MEH (H|3)

1 Select a wizard

Create a JUnit Test Suite

Wizards: | JUnit Test Suite

fype fitr text i &, This package name is discouraged. By convention, package names usually E[
& Interface start with a lowercase letter
12 Java Project
¥ Java Project from Existing Ant Buildfile

—import org.junit.runner.Runkith;
import org.junit.runners.Ssuite;

() New JUnit 3 suite (@) New JUnit 4 suite

145 Java Working Set Source folder: | Tester/Test Browse... @RunkWith(suite.class)
Packa Suite.suiteClasses
& Package Package: TestMessageltil Browse... @ . {{
£ Source Folder TestJunitl.class,
b @ lava Run/Debug flame: Allests TestJunit2.class
4 = JUnit

Test classes to include in suite:

by

public class TestSuite {

b

© Testunitt Select All
@ Testlunitz
® Testsuite

L I I RN B o R

 JUnit Test Case
[ JUnit Test Suite

Deselect All

3 classes selected




7. Test AlsH Sl A}
1)test case A2A0A run HE &l

> JUnit Zi} % 201 745 (method A8 AJZt, failure 015 5 )
£ Java-)UnitTestsy/src/CalculateSampl

File Edit Source Refactor Mavigate Search Project Run  Window Help

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
: N-E-HR& L-H G- dO AP ApEONLF 00
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|

Fé Package Explorer |gfu JUnit 2% | Run CalculateSampleT:estS ferviceltemT... | [J] CalculateSam... [m Calculat

==

BH @l—ﬁ| % '-¢: ls.E-J - = , ,
Finished after 0.032 seconds * @throws java.lang.Exception
*
pafter
public void tearDown() throws Exception {

sample=null;
b

@Test

public void testGetSum() {
assertEquals(l,sample.getsum());

h

@Test

public void GetAverage() {
assertEquals(®.5,sample.getAverage(),1);

b

iTest
public wvoid testGetMultiply() {
assertEquals(@, sample. getMultiply());

Runs: 444  HBEmors: 0 B Failures: 0

4 |f] CalculateSampleTest3 [Runner: JUnit 4] (0.4
el GetAverage (0.075 g)
el testGetDivide (0.000 5
el testGetSum (0.000 5)
el testGetMultiply (0.000 5)

1

[@Test(expected = ArithmeticException.class)
< > public void testGetDivide() throws Exception {
= Failure Trace 50 o= assertEquals (@, sample.getDivide(),8.1);
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How to use JUnit

7. Test AlsH Sl A}
1)test case 2AA0|A| run HE 22l

- failO| 2tMigt AL JUnit A1 &0 A =2kl 7F=SICt

{8 Package E:-cplurer|m'UJUnit ot | = B8 || [ serverThread... |m Serviceltem.... ‘ [3] serviceltemnT... | [ cal
T 5E| Q. B =« = 19 * ([@throws java.lang.Exception
Finished after 0.031 seconds 28 */
219 patter
Runs: 4/4 (1 skipped B Errors: (B Failures: 1| 22 public void tearDown() throws Exception {
23 sample=null;
I | =+
25
4 F CalculateSampleTest3 [Runner: JUnit 4] (0.0} 26= {@Test
Q Getawverage (0.000 5) 27 public wvoid testGetSum() {
:F'—_l testGetDivide (0.000 5) gg ) assertEquals(l,sample.getSum());
el testGetSum_-:t—.l:—l:—l:— 5) 308 frest
|l testGetMultiply (0.000 g)| 31 @Ignore
32 public woid GetAverage() {
33 assertEquals(l,sample.getAverage(),1);
34 1
@Test
public woid testGetMultiply() {
assertEqual s (1818, sample.getMultiply());
¥
[@Test(expected = ArithmeticException.class)
< > public wvoid testGetDivide() throws Exception {
= Esilure Trace ) assertEquals(@,sample.getDivide(),8.1);
11 java.lang.AssertionError: expected:<1010> but v
= st CalculateSampleTest3 testGetMultiply(Calcul




7. Test Al 51 A0
2)TestRunnerZE 0| &

Runners @2 &l annotationS A0pA testst A4S 4t

1= import org.junit.runner.JUnitCore;
import org.junit.runner.Result;
import org.junit.runner.notification.Failure;

= ETETE

Setup

Inside testPrintMessage()
Robert

tearDown

Inside testSalutationMessage()
Hi!Robert

[erue ]

A P& pass =l AL

N I RN, QR - T

LU U T S o I ]

public class TestRunner {

Lt

[faiee]

public static woid main(String[] args) {

=Lt

Result result = JUnitCore.runClosses(TestSuite.class);
for (Failure failure : result.getFailures())} {

System.owt.println{failure.toString()

}

system.out.println({result.wasSuccessful(

}

|H
)}H

<terminated= TestRunner (1) [Java Application] C:#Program Files#lavawjre1.8.0_3 1#bin#javaw.exe (2015. 3. 19.

Inside testPrintMessage()
Robert

tearlown

Inside testSalutationMessage()
Hi!Robert]

testSalutationMessage(Test.TestIunit2):

expected:<Hi![;//]Robert> but was:<Hi![]Robert:

A Failo

HS o
| At 59



8. A 12| Tip

4 = dummy

(default package)
. [J] CalculateSample java
4 [ sro/Test

4 2 dummy

|_ || CalculateSam |EI'|E'TE51I java

- @ JRE Systemn Library [JavaSE E-1.8]
» B JUnit 4

|
|
I
|
|
|
|
|
I
I
|
I
|
|
I
I
|
[
|
|
[
|
|
: 4 [ src
|
|
|
[
|
|
|
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
|

2 package£ BH=11,
IS0 CiSt test packageE = BH=0
J0| EHS|LCt

. http://www.androidpub.com/39606
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PART 4 Build Environment

What is Build Environment ?

® AT EQ|0| HE(software buildye AA FE THAS ARHOM et A=
o AZELY Vs BRsts 1PdE ToLE 0] tiet 2ltsS Y=L

® AIZEQ0 EEO A0 7HY Tt HAIS 7H2H| Stbts &4 E TpU0| 4l A
C 2 Bgte|= Aot uPgo|Cf.

%Ef%' /HIAE /Oj{7 |7§> B / A2}

® Ant, Gradle, Maven 50| QIC}.



DLEE ot 2efg 4= s Z2AO|CE

® Redmine, Trac, Jira &

® zhyujuo| 2780 et UM Z2MES HA LEY 5 U= 2HES MSdliF= SOIt,

® Ant, Maven, Gradle =

3. H{A D Z2
® siLto| 20| Oj2 Do WRE WAL ¥ ChYS HH ZRIBOR
sl 4 Ut

o BUlHoZ 442 BaY

® SVN, CVS, GIT, Source Sfae &

A Tkz| T2 J2o|Ck

n o>
30
=
|.|-|
o
ald
rr
m
o
£
-

-



PART 4 Build Environment

What is Ant ?

® XtHf 7[Hro| £ E XSt =+t
Ant= AKX M A EHH H|O[H|Z0f 2f5H
orEA, 0] 52 A= 7H0|2f HEHRt H|w k| 7| = S,

O Ant= 11 X}A|7} Java Z7|HFO|HA xmIZ2 O|20{X

T 2|7t Hajsot

OANtO| TR 7=
® XHHp A Il AIb
® jar, war, ear, zip I}O| MY
® Javadocg AlsHSI0] =20 AlA
® nAO|Lt ZHQ| Ols A =AL AFA|
® Q|5 Iz 20| Al

HAHE|A=0|, 0|42 Another Neat Tool= 2|0|

| =0 ZE & 8i HE0] &

PACHE ANT>
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How to install Ant

1. Ant CF&2E

Apache ant 21§ 0| X| &< : http://ant.apache.org/bindownload.cgi

Home &4 - Binary Distributions 2 &l

Apache > Ant apache

Y ITHE

APACHE ANT
PROJECT ==

Home

+ Apache Ant
= Welcome
o License
o MNews
o Security Reports
+ Documentation
Manual
Related Projects
External Tools and Tasks
Resources
Frequently Asked Questions
wiki
Having Problems?
» DNownload
o Binary Distributions
o Source Distributions
= Ant Manual
¢ Contributing
Mailing Lists
Git Repositories
Subversion Repositories
Nightly+Continuous Builds

<AFACHE ANT>

Binary Distributions

Apache Ant™

Apache Ant is a Java library and command-line tool that help building software.

Downloading Apache Ant

Use the links below to download a binary distribution of Ant from one of our mirrors. It is good practice to verif

especially if you are using one of our mirror sites. In order to do this you must use the signatures from our m

1)

Ant is distributed as zip, tar.gz and tar.kzZ archives - the contents are the same. Please note that the tar.:
than 100 characters and have been created using GNU tar extensions. Thus they must be untarred with a GNU

In addition the JPackage project provides RPMs at their own distribution site.

If you do not see the file you need in the links below, please see the master distribution directory or, preferabl



http://ant.apache.org/bindownload.cgi

PART 4 Build Environment

How to install Ant

1. Ant CIREE

Current Release of Ant

Currently, Apache Ant 1.9.4 is the best available version, see the release notes.

Ant 1.9.4 was released on 05-May-2014 and may not be available on all mirrors for a few days.

Tar files may reguire gnu tar to extract

Tar files in the distribution contain long file names, and may reguire gnu tar to do the extraction.

» .zip archive: apache-ant-1.9.4-bin.zip [PGP] [SHA1] [SHAS512] [MD5]
* .tar.gz archive: apache-ant-1.9.4-bin.tar.gz [PGP] [SHA1] [SHAS512] [MD5]
+ .tar.bz2 archive: apache-ant-1.9.4-bin.tar.bz2 [PGP] [SHAL1] [SHAS512] [MD5]

V /Users/{Username}/DocumentsOf| r=38l{A| C|HEZ|E 7}HCH =0 H APAAF K]

TR

M apache-ant-1.9.4

M Aptana Rubles

rir

11
=
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How to install Ant

profileo]] QIE20] &z MEBIS0| bin7tX| Z2E 0j2] XEAZICH
O XS A|E=RHCHH profile 2 @2 L, "vim .profile" =2 BH=LCL

baghyeongyuui -MacBook-4ir-2:~ caninef 1s -z

+
'_'l
o O

canine staftf GG
Foot admin 24
canine staftf )
canine staff 15364
canine staff (TF5]
canine staftf
canine staftf
canine staff
canine staftf

18 18
18 @917 ..
10 17:39 CFUserTextEncoding
13 158:56 D% Store
18 17:06 .Trash
15 i Jbash history
.cups_
eClipse
profile

L b

Wl = bl =

L kJ oL

=

-rW-r--r--

vV AbM|S| 23 windowOf| N 2tE R d8ot= Adf R CIEX] BT

xport ANT _HOME={UsersdcaninesDocumentssapache-ant-1.9.4
xport PATH=%{PATH}:%{ANT HOME}/bin
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How to install Ant

baghyeongyuui -MacBook-Air-2:1~ caninef source ~/.profile

Lpache &nt(TM) wersion 1.92.4 compiled on April 29 26014
baghyeongyuui -MacBook-8ir-2:~ canined
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2) Windows?2| 4%

LHAFEH > LEZ OIRA 2

22(G)
AlE SHEO] DF(P)
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(N ES-E-TETTINPIES

AH O 72 3=

Windows HH

Windo

croed S m Wind

Indu&tr
Pro

=]
2013
Micros
Corpor
Al
rights
reserve



2. 81 B4 A

—

2)Windows2| 4<%

NES-TEY ]

S A~
2 8>3 4 29

i=
e
oo
ufo
rE
ol
_I'3_|
i
rg
e
U
=
u
ru
[
ro
=
=
et
i
i

MEZEZ

M-S 22010] BEE S 51E 47

il
re




—

2. 34 4 M

2)Windows2| 4<%

A|AH B4 A2 BHE7| > JAVA_HOME (DK A X| directory) 444

MO_XILINX_DATA_... HIDDEN
%eUSERPROFILEXwAppDatawLocalwTemp
2:USERPROFILEMAppData¥Local®Temp

| JAVA_HOME

- || BrE. || #Ao

| C-#Program Files#lavawidkl 8.0 :

C:HWindowswsystern32wcmd.exe
FP_MNO_HOST_CH.. NO
JAVA_HOME C:#wProgram Filesitlavawjdkl.8.0_31
MUMBER_OF_PRO... 4

W

| ME HS21(W)...
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2) Windows?2| 4%
A|AH A HE S Path0f| Ant AX| ZAZ2/bin 27}

JAVA HOME C:AProgram Filest¥lavawjdk1.8.0_31
NO_XILINX_DATA_... HIDDEN

TEMP %eUSERPROFILEXwAppDatawLocalwTemp
TME 2:USERPROFILEMAppData¥Local®Temp

2PN || BEE. || 4O

ZF
A

ComSpec C:HWindowswsystern32wcmd.exe
FP_MNO_HOST_CH.. NO
JAVA_HOME C:#wProgram Filesitlavawjdkl.8.0_31

MUMBER_OF_PRO... 4 o

e | AL

Fath

2rsiE SH¥Downloadsitapache-ant-1.9 4%bin;

& Ant (%] Z2)/bing 71 50| ZABIM EelCt
717t0| pathS2 ; (M| 2R)02 PEEIC)

20| ;" 207
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2)Windows2| 4<%
Tools.jar7t QICH= @ =7} 2l

ool e A AR E(U)

ot A2 > A|AH B Path0f| (JDKEX|AZ}/bin 7}

B o

JAVA HOME C:AProgram Filest¥lavawjdk1.8.0_31
NO_XILINX_DATA_... HIDDEN

TEMP %eUSERPROFILEXwAppDatawLocalwTemp

™P ZUSERPROFILEX:AppDatawLocalTemp

Path |
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PART 4 Build Environment

How to install Ant

3.C[HED 4d

oo EHE ddoto], O 50| = 22 Lt 8l EHES d-doll =Lk

B build.txt
B class
@ document
B ant workspace il jar
B apache-ant-1.9.4 B e
B Aptana Rubles
B Aptana Studio 3 Workspace A TH Gl E AL

A Qo|o| ZH AN
. N i build A mpel
Build.xml : build 27 m}
S

Src P AN EH
Class  Antelst SaA ot 24
Jar CHE T =

Document: document Iotg =0

(build 3t CHOFCE AR EHZ4 7



4. Build.xml It 2HM
L

PART 4 Build Environment

How to install Ant

o
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<?xml version="1.8" encoding="UTF-8" 7»

cproject names="ant_test" defoullp="compile” basedir="/Users/canine/Documents/ant" =
sproperty name="src.dir" value="%{basedir}/src" /=
sproperty nome="classes.dir| volue=s"%${basedir}/class" /=
<property name="jar.dir" volue="${basedir}/jar" /=
<property name="javadoc.dir| value="%${basedir}/document” />

1) Default="compile”
‘default : Z=7|X| 2 2YE[= &Y, OrF A= X|'§oHA| 541 2 ASHH Of s o

ofl e AI'8 EHITHK| &S Asi== XO|C.

2)Basedir: "ZE2MEO| HA=Z"
3 ) ${basedir}/src, ${basedirl/class... : “X}

Rai
o
bal
1R}
-
0x
Ot
[t
ini
m|n
10
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ol



4. Build.xml It 2HM

<target nome="compile” = <target>.. . </target> LHE =

cjavac srcdire"${src.dir}"” destdir="${classes.dir}" /= 9 N / 9 H_T_L'
ST xS THAIRIST s 715
<target name="jar" depends="compile" = %Olﬂl‘ﬂ )glj—ll'ol-ﬁ EI_“:l-

includes="**/% class"

- : = o|x =
/> JarS 20| A XL0| REStH= O] §2
</ target= o o
2 jarnds ddg = AL,
<target name="jovadoc" depends="compile, jar" =
<javodoc
sourcepath="%{src.dir}” W HE5 A KEAIO| RlEH=
5DUPCEF'.1E5-"${5FC-dir‘j.-’nni:_test_jm:n" Javadoc _'_O-” -I |- |_r |-'—
windowtitle="helloant” . JavaLLIO'O A—II—Iol.O:I 9-|_|_|_|- | S E|- =
destdir="%{javadoc.dir}"
/= AAE}'
</target=

<target nome="clean" =
cdelete dir="${claosses.dir}*" /=
<delete dir="${jar.dir}*" /=
<delete dir="$fjovadoc.dir}*" />
</target=

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
[ <jar jan:le-"${jnr.dirgfhelln-jnr"
: bosedir="${classes.dir
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
|
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PART 4 Build Environment

How to use Ant

1. Command & Al Ant AlSHS}HD |

TZ2HNME ZHZ 0|z = buildxml =X 22 = > “ant” 2 .class Lt AHM |

gimmin-uui-MacBook-Pro:SV_Test minwookim$ ant
Buildfile: /Users/minwookim/Documents/workspace2/SV_Test/build.xml

build-subprojects:
init:

build-project:
[echo] SV_Test: /Users/minwookim/Documents/workspace2/SV_Test/build.xml

build:

BUILD SUCCESSFUL
Total time: ©® seconds

A ant —file (ZE2ME A2} 2 & AlPH0| 7+=SICE



2. EclipseOf| A Ant A&HS}7|

S E I3t build.xml & OtLY 7|

ant

Z2NE lojM Q2% 019

—> Export

8 00

= Java - SV_Test/src/HelloSV/HellowSV.java - Eclipse -

g

:#'O'Q':'&};G‘;';Q@:ﬂa': ® \9‘ v i

[£ Package Explorer &2

¥ (#src
¥ {41 HelloA®
» [J] Help
v {41 HelloSV
» [J] Hellc
P =\ JRE Systerr

SV_Test

= B8 [J] HellowsV.java £

1 package HelloSV;

> \NT.HelperClass;

New
Go Into

HellowSV {

iatic void main(String[

IDO Auto-generated metk
F4 ystem.out.println("Hel

Open in New Window
Open Type Hierarchy

Show In W p» lelperClass().PrintHell
(5 Copy 8C
=5 Copy Qualified Name
. Paste #V
X Delete ®
Remove from Context el
Build Path >
Source S >
Refactor N#T >
s Import
t 1 Export |
« Refresh F5
Close Project
Close Unrelated Projects
Assign Working Sets...
Profile As > loc Declaration B Con
DebuQ As f lava Application] /Library/)
Run As T PP o
Validate class
Team >
Compare With >
Restore from Local History...
Configure >
Properties |




How to use Ant

2. EclipseOf|A] Ant AJSH

[

o

=

General > Ant Buildfiles > Next > Of2ff H|348A x| (Eclipsel| ! AL QFsH

® 0O 06 Export

Select

Generates Ant Buildfiles for Eclipse Java projects.

Select an export destination:

A

=

i type filter text

I Archive File
L File System
[TPreferences

P (=EB

P (= Install

P (= Java

P (= Java EE

P (= Plug-in Development

P [~ Remote Systems

P (=~ Run/Debug

P (= Tasks

P [ Team

P (>Web

P (= Web Services

P (= XML

I Next > I | Cancel

@I < Back

Vv [~ General
. Ant Buildfiles

Finish

|8 0 6 Export

Generate Ant Buildfiles

Generates Ant buildfiles based on the configuration of the Java projects

Select the projects to use to generate the Ant buildfiles:

o Elsv_Test

¥ Check projects for Ant compatibility

| Create target to compile project using Eclipse compiler I

Name for Ant buildfile: ' build.xml

JUnit output directory: | junit

(?) < Back Next > Cancel

| Select All

Deselect All

| Finish




' PART 4 Build Environmen

How to use Ant

2. EclipseOf|A Ant

Astst|
buildxml > @EZ 02 A - Run As 2 Ant Build

v () SV_Test 1 <?xml version="1.0" encoding="UTF-8" standalone="no"?>
v (@@ src 2= <l-- WARNING: Eclipse auto-generated file.
¥ {#} HelloANT Any modifications will be overwritten.

4 To include a user specific buildfile here, simply create one in the same

4] HelperClass.java . directory with the processing instruction <?eclipse.ant.import?>

¥ {4 HelloSV

€ as the first entry and export the buildfile again. --><project basedir="." defal
¥ |J] HellowsV.java 7 <property environment="env"/>
¥ ) JRE System Library [JavaSE-1.7] . <property name="debuglevel" value="source,lines,vars"/>
: roperty name="target" value="1.7"/>
New P iroperty name="source" value="1.7"/>

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I lath id="SV_Test.classpath">
I Open F3 <pathelement location="bin"/>
I Open With » 'path>
" iarget name="init">
I Show in X aeW » <mkdir dir="bin"/>
<copy includeemptydirs="false" todir="bin">
I (& Copy #C <fileset dir="src">
I i Copy Qualified Name <exclude name="**/* launch"/>
“ Paste .V <exclude name="**/*, java"/>
I S </fileset>
X Delete B /copy>
I 'target>
I Remove from Context \ w1 larget name="clean">
<delete dir="bin"/>
| ‘target>
iarget depends="clean" name="cleanall"/>
I \arget depends="build-subprojects,build-project" name="build"/>
I iarget name="build-subprojects"/>
L« Import... \arget depends="init" name="build-project">
I <echo message="${ant.project.name}: ${ant.file}"/>
I <javac debug="true" debuglevel="${debuglevel}" destdir="bin" includeantruntime="false'
<src path="src"/>
I <" Refresh F5 <classpath refid="SV_Test.classpath"/>
Assign Working Sets... </javac>
I ‘target>
I Validate iarget description="Build all projects which reference this project. Useful to propagate
Show in Remote Systems view iarget name="HellowSV"> )
I 0 doc Wizard <java classname="HelloSV.HellowSV" failonerror="true" fork="yes">
pen Javadoc Wizard... <classpath refid="SV_Test.classpath"/>
I Profile As > </java>
I b
I
I
I
|

Mark as Landmark " {38
Build Path
Refactor 8T

vy

. Export...

X x
nes/jdk1.7.0_71.jdk/Contents/Home/bin/java (2015. 3. 19.

Team

Replace With
JPA Tools
Compare With

# 2 Ant Build...

External Tools Configurations...
neLpeErciuss>

>
>
>
>



2. EclipseOf| A Ant A&HS}7|

buildot Z 1t

Problems Javadoc Declaration &) Console 33 # Ant

—<terminated> SV Test build.xm| [Ant Build] /| ibrary/lava/lavaVirtualMachines/idk1.7.0_71.idk/Contents/Home/bin/java

Buildfile: /Users/minwookim/Documents/workspace2/SV_Test/build.xml
build-subprojects:
init:
build-project:
[echo] SV_Test: /Users/minwookim/Documents/workspace2/SV_Test/build.xml
build:
BUILD SUCCESSFUL
Total time: 626 milliseconds




PART 4 Build Environment

What is Gradle ? ;\

¢ IZNE L4 EE
Ant2} Maven O|=20f Lt=2 E T2, XML 2E E2 2H4E 0 QUCL

® Groovy A0 7|Ht

xmlZ 7|8te 2 St= AntL} Mavenit= 22|, Groovyet= AN E 7|HI O 2 SHC}

Maven

® AntQt H|ZSHLE Z2ME e S flet S E TS0 Z2NE F2|E
® Pom.xml0f| Z2NME JAXQ A HO|
® Maven?| tHA

CtE Z2NETE 5 o527 2 275H0f oot

XMLE ZEIYS 2-dSt=0|, w227t S &SIC

AFEAZEC] 221210 L2 20| CiA| 7|=0HOF BT



Gradle vs Ant(Maven)

® build ot o] L EQF Gradle H| !

task hello {
doLast {
println 'Hello world!'
}

h

A Build U2 HOJAM 2OISHE M task = targetd}f CHS 0| E|H, St= 7|2

<target name="jar"
<jar jarfi

depends="compile"

basedir="%{classes.dir}"
includess"**/* claoss”

S
</target=

Task, 0|2] W= 2PH0|A 80 & LSS HolE Zolck
OlE S0, AHHf Z2HES B E STt

Source Compile, BEF|HIAE, Jarid 52 =s|{OF Sl=0,
0| TaskE 2t A= AHE WE 3 4 QUChs Z{o|ck

> HEO| XI==t

QLEZ UK = Taske| Of|A| >

task hello
"Hello

hello.doFirst
'Hello

hello.doLast
'"Hello

hello
'Hello

74| H

PART 4 Build Environment

-

le="%${jar.dir}/hello. jar"

Earth'

Venus'

Mars'

Jupiter'

SOIL.



PART 4 Build Environment

Gradle vs Ant(Maven)

® build ot o] L EQF Gradle H| !

<dependencies=
<dependency=
<groupld=junit</groupld= dependencies() {
<artifactld=junit</artifactld= VS testCompile ‘junit;junit:3.81'
<version=3.8.1</version> }
<scope=test</scope=
</dependency=

</dependencies=

dependency= StLf Mgk M{OHC) xml THAO A= &[4 6F 0] &= 25l OF ST

J2{L} groovyOj| M= £t 35 0| dependency M Q10| 7Hs38iCt

F7tote SE0| Bote =& SEd2| Aol [ AHZIC,



1. Gradle CF22E

Gradle 214 0| X| &< : http://www.gradle.org/downloads

Complete distribution

DOWNLOAD GRADLE

The latest release of Gradle is version 2.3,
released on 16th February 2015.

distribution (binaries, sources

and offline documentation)

inary only distribution {(no
documentation or source code)

radle sou de (just the Gradle
source code: not a usable Gradle

installation)


http://www.gradle.org/downloads

PART 4 Build Environment

How to install Gradle

B Aptana Studio 3 Workspace
B eclipse

M gradle-2.3

B Microsoft User Data

VAN ==k I

xport GEADLE HOME=/Users/canine/Documentssgzradle-2.3
xport FATH= IL "THJ.I[hEHDLE_HUHEJ ‘bin

F

rlot
ox

AWindows2| 420 = A|AH! H=~ PathO| Gradle AX| 42 =7}

baghyeongyuui-MacBook-Air-2:~ caninef source ~/.profile




3. ™ X3
2015/03/19 7|Z=2 2 2. 3#{T0| X|Alo|C.

gradle -v
baghyeongyuui-MacBook-4ir-2:~ canined gradle -w
Build time: 2015-02-16 05:09:33 UTC

Euild number: none
Fevision: Liober2bfoeddfleereredlf2a3aTdRler341274

Groowvy:

drt: Apache Ant(TH) wversion 1.9.3 compiled on December
JWH 1.6.8 65 (Apple Inc., 20.65-bA4-452)

as: Mac 05 X 1@.,9.5% x86 64

£t

2013




4. T2 M E injtiate

gradle init —type groovy-library

baghyeongyuui-MacBook-4ir-2: testgradle canine| gradle init --type groowy-library
rWrapper
vinit

BUILD =SUCCESSFUL

Total time: 3.65]1 secs
baghyeongyuui-MacBook-Air-2: testgradle caninef 1s
build.gradle gradlew settings.gradle
Zgradle Zgradlew.bat SrC




How to use Gradle

® Build.gradle

apply plugin: 'qroowvy’ Plugin A& 715 : task | & =2 &3

Ff In this section you declare where to find the dependencies of your project

ff Use "jcenter' for resolving your dependencies.
// You can declare any Maven/Ivy/file repository here.
jcenter()

AHp ZEMEO| F2,
QE jar mO| ST =2
ME Yoo Badt B
=t

Ff In this section you declare the dependencies for your production and test code

dependencies {

Ff We use the latest groovy 2.x version for building this library

compile 'org.codehaus.groovy:groovy-all:Z2.4.8"

// We use the awesome Spock testing and specification Tramework
testCompile 'org.spockframework:spock-core:0.7-groovy-2.0"

testCompile 'junit:junit:4.12°

|
|
I
I
|
I
I
I
I
I
I
I
I
I
I
I
|
I
|
[
[
[
[
: repositories {
[
[
[
|
I
[
[
[
[
[
I
[
[
[
[
[
I
[
[
[
[
[
|
|



PART 4 Build Environment

How to use Gradle

® Build.gradle

dependencies |
compile group: 'org.hibernate', name: 'hibernate-core', version:

/7 BA M0 "group:name:version”
dependencies |
compile ‘org.hibernate:hibernate-core:3.6.7.Final’

A 7|22H 9l dependencyl| 0

2 oMz MYe 2fF 2r0|=Eed| Aottt RE A3 HENAM Y o[EdE XIS

—

// In this section you declare the dependencies for your production and test code

dependencies {
ff We use the latest groovy 2.x wversion for building this library
compile 'org.codehaus.groovy:groovy—-all:2.4.8°

/f We use the awesome Spock testing and specification framework
testCompile 'org.spockframework:spock—core:@.7-groovy-2.0"
testCompile 'junit:junit:4.12°




* References

Downloads
® http://www.oracle.com/index.html : JDK
® https://eclipse.org/downloads/ . Eclipse
® http://ant.apache.org/bindownload.cqi - Ant
® http://www.gradle.org/downloads : Gradle

References

® Introduction to CTIP-15SV.pdf
® At JHE A &1 SEA HiR= HI2E O[07|"

Ot
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r

® http://en.wikipedia.org/wiki/Continuous integration ® http://dynaticy.tistory.com/1

® http://en.wikipedia.org/wiki/Unit testing

® http://www.vogella.com/tutorials/JUnit/article.html

® http://blog.naver.com/kittenjun/10165921021

®_http://dongsilove.tistory.com/entry/junit-test

® http://www.androidpub.com/39606
® http://donzbox.tistory.com/384
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